
Recommended Reading
There are many incredible features and useful tips in this online Help. To get a better understanding of 
GoBack, there are two sections that really must be read: First, jump ahead to the Tutorials section. It 
will give you a practical sense of some of GoBack’s abilities. Next, read Do I still need to make 
backups? in the Frequently Asked Questions section. Here it is explained why it is important that you
continue your normal practice of backing up your computer.



Introduction
What is GoBack? GoBack is the missing piece of the operating system. It is neither a backup/restore 
product nor a utility product. It is a remarkable tool that integrates itself into the operating system to 
protect you from data loss. This includes the everyday "oops" that occur from user error or software 
problems, file recoveries of deleted or overwritten files, virus attacks, problems from software 
installation, and even system crashes. Generally, with GoBack installed, you can easily back out of 
trouble, regardless of whether it was caused by you, your system (non-hardware-related issues), or 
software. Even a "crashed" system that won’t allow your computer to boot usually can’t stop you.
With GoBack enabled, as you use your computer, GoBack keeps track of every move you make that 
affects your hard disk, allowing you to go back in time. You can retrieve specific files or entirely restore 
your hard disk. The amount of hard disk space that you set-aside on your computer for GoBack 
determines how far back in time GoBack is able to retrieve information. Typically, if 10% of the hard 
disk is set-aside for GoBack, it can maintain at least one week’s worth of data.
GoBack is not just another backup product because, unlike a traditional backup product, GoBack does 
not involve copying data to a separate tape or disk. Thus there is no specific point in time where you 
must stop and make a backup. Your system does not even need to be operational in order to restore 
data. Therefore, mistakes can be corrected without having made a backup.
GoBack provides three essential services. It lets you:

· View your hard disk as it was at an earlier time.
· Revert your hard disk to an earlier time.
· Retrieve specific files from the past.

When you view or revert your hard disk to an earlier time, you essentially specify a date and time. On 
the other hand, when retrieving and old version of a specific file, GoBack will scan its notes and 
generate a list of available versions, each corresponding to a time in the past.



After Installation
After you’ve installed GoBack, you will notice a few changes to your Windows desktop. If you’ve so 
requested, an icon (shortcut) will be placed on your desktop. There will also be a shortcut placed in the
status area of your taskbar (near the clock), from which you can access GoBack.
After installation, GoBack continually protects and monitors your hard disks without requiring any 
action on your part. With the data GoBack has collected, you can:

· View the past by creating a virtual GoBack Drive and use it like any other drive.
· Bring the past forward by reverting your entire hard disk.
· Recover files, including deleted and overwritten files.

The procedure for uninstalling GoBack follows the standard Windows convention (use Add/Remove 
Programs from the Control Panel), which is explained in detail in the section Frequently Asked 
Questions.



Starting GoBack
After GoBack is installed, it automatically runs whenever you start your computer (unless GoBack has 
been disabled). The GoBack Main Menu can be started one of several ways:

· Click Start, then Programs, then GoBack.
· Click on the GoBack icon in the taskbar.
· Right-click on the GoBack icon in the taskbar, and then select one of the main GoBack functions 

from the pop-up menu.
· Double-click the GoBack icon on the desktop (if available).



What GoBack Can Do for You
As GoBack monitors and records all information being written to your hard disk(s), it provides you with 
a number of ways to view, copy, or access the information it has recorded.

View Your Hard Disk as it was in the Past
You would typically view your hard disk as it was in the past for the purposes of retrieving an entire 
directory or looking at a set of interdependent files. This is done by creating a virtual GoBack Drive, 
whose contents correspond to your real hard disk as it was at some time in the past. For example, if C:
is your hard disk, then you might ask GoBack to create a virtual GoBack Drive corresponding to C: as it
was an hour ago. The virtual GoBack Drive you create will automatically be assigned a drive letter (for 
example, D:). This drive D: is very much like a backup of your entire hard disk drive that was made an 
hour ago. You access drive D: in the same way you would your floppy disk A:. While you are 
maintaining a virtual GoBack Drive the system must spend a certain extra effort keeping the virtual 
drive up to date. Thus, when you are done using your virtual GoBack Drive (drive D:), you should ask 
GoBack to discard it.

Revert Your Hard Disk to an Earlier Time
There are two primary reasons why you would revert your entire hard disk to an earlier time.

· You may have installed new software or made some modification such that your computer no 
longer works properly (e.g., it will not boot). Perhaps you added new hardware, followed the 
instructions to add the device drivers, but something went wrong, and although you can 
physically remove the new hardware, you need to "undo" the system changes to get back to 
where you were.

· Your computer is generally working, but you would like to undo a recent change to the system 
and you do not know what files to restore. Perhaps you started reading your e-mail, and as you
do, you print it out and delete it, only later to find that the printer was out of ink. Ordinarily, you 
would be out of luck. The e-mail is gone. However, with GoBack you can revert your entire 
hard disk to before you deleted the e-mail and presto, it is back.

The common thread in these examples is that you really do not know what specific data to restore in 
order to back out of a problem. Or even if you do, it is easier to revert everything to some time in the 
past.

Retrieve Specific Files from the Past
For those times when you don’t want to completely revert your hard disk just to get back one deleted 
or overwritten file, you can use the GoBack File Recovery Window or the GoBack shell extension in 
Windows Explorer. Here you can select from various versions of a file by name and date, and either 
restore it or just bring it back for quick viewing.



GoBack Scenarios
After you’ve started using GoBack regularly, you may come to wonder how you ever lived without it. 
There are so many instances where "Undo" doesn’t do it, and your tape backup wasn’t made an hour 
ago so it won’t help. The following examples illustrate how you can use GoBack to avoid wasted work, 
save time, and avoid aggravation.

· At 7:20, you installed some new software. By 7:35, nothing worked. The uninstall at 7:40 didn’t 
work either. Use GoBack to revert your disk to 7:20 and start over.

· At 9:15, you started work on your big, monthly progress report using last month’s report as a 
template. At 9:50, you save your work, only to realize that you’ve just saved this month’s report 
over the only copy of last month’s report. Use GoBack to go back to 9:15, retrieve last month’s 
report and save it somewhere else, and then return to 9:50 where you left off.

· You downloaded something from the Internet and things just don’t look right. Sure enough, your 
virus checker found something. Let GoBack take you back to the time before the download.



Accessing GoBack Services
After installation there are three ways to access GoBack's services:

· By launching the GoBack Main Menu.
· By right-clicking on a specific file from within Windows Explorer.
· By pressing the spacebar at the GoBack Boot Screen. 

The GoBack Main Menu, which is launched like any other program from within Windows, is the main 
interface into GoBack through which most of its services can be accessed. Here you can create a 
virtual GoBack Drive, retrieve specific files, or entirely revert your hard drive. The Main Menu takes you
to two major windows: the GoBack Drive Window and the File Recovery Window.
The GoBack shell extension into Windows Explorer provides a convenient way to access old versions 
of a specific file, although somewhat similar functionality is also available through the GoBack Main 
Menu.
The GoBack Boot Screen appears briefly before the operating system starts (when you turn on your 
computer). By pressing the spacebar you can access a limited set of functions. This interface is used 
primarily in emergencies.



Tutorials
The following tutorials will illustrate what GoBack can do and how to use it.

To fully demonstrate the capabilities of GoBack you 
will be instructed to delete or modify existing files. 
You will then use GoBack to retrieve those deleted 
files or earlier versions of files. If you want, you can 
make a backup of any files before deleting or 
modifying them.
Before you begin, verify that GoBack is installed and 
that you can access the GoBack Main Menu.

Reverting Your Hard Disk
In this tutorial, you are going to delete a number files from your computer and then revert your entire 
hard disk to the past to demonstrate that your hard drive can be restored to the way is was.

1 Restart your computer (click Start, Shut Down, then Restart). This step is present to simplify the
example. 

2 In Windows, using Windows Explorer, delete at least one file from a folder on your C: drive.
3 Empty your Recycle Bin (right-click Recycle Bin then click Empty Recycle Bin from the shortcut

menu). At this point, the file(s) you deleted is, for the most part, irretrievable.
4 Now you will use GoBack to revert the drive to a time corresponding to when the file(s) existed. 

For this tutorial you will do this from the GoBack Boot Menu. You can always access the GoBack 
Boot Menu – even if Windows doesn’t start. To do this, restart your computer, press the reset 
button, or turn the power off and back on.

5 When the GoBack boot screen message appears, quickly press the spacebar. This will open the 
GoBack Boot Menu.

6 From the GoBack Boot Menu, click the button labeled Revert Drive (or press the letter "R"). 
GoBack will then suggest times in the past to revert your hard disk to. These times will be some 
time before you deleted the files in Step 2.

7 Select a time at which you know the file(s) existed, click Revert, and follow the on-screen 
instructions. GoBack will then proceed to restore your hard disk to the way it was at that specified
time and reboot the computer.

8 This time, when the GoBack Boot Screen appears, do not press the spacebar. Let the computer 
boot as normal. After Windows starts, you can verify that the deleted file(s) has been restored 
and the hard disk is back to the way it was.

9 If you want, you can repeat this procedure to revert to an earlier time. You can even revert to a 
time just before the last revert – essentially going back "to the future" again!

Recovering an Overwritten File
Have you ever overwritten or deleted a document or other file and wanted to go back to the old 
version? You can do this easily with GoBack. In this tutorial you will modify a file, save it (overwriting 
the original), and then retrieve the original file.

1 Open one of your data files (any file in the My Documents folder should work).
2 Modify the document in some way. For example, if you opened a Microsoft Word document, you 

could delete some of the text or add new text to the document.
3 Save the file. This will replace the original with the new, modified version. Note that if a file is 

saved twice in quick succession (within about 10 seconds) there is a chance that GoBack will not
be able to recover the interim revision. However, earlier or later versions are still recoverable. 
(GoBack requires that your computer’s disk be idle for a few seconds in order to identify 



"boundaries" between different versions of a file.)
4 Now close the program you used to edit the file. At this point, the old version of the file is lost and 

cannot be recovered by any conventional "undelete" utility.
5 In Windows Explorer, right-click the file you just modified. Select Show Revisions on the pop-up 

menu. GoBack will display a list showing all the versions of the file that can be recovered. The 
first (top) entry is the current version, and the second one is the file that you overwrote.

6 Just to make sure, click the second file then click the Open button. This will open the old version 
of the file. If this is the old version, you can:

· Close the program that started, click the Recover To button, and select a location in 
which to save the file.
- OR -

· To replace the current version with the previous one, you can just click Save in the 
program. The original file is recovered, replacing the modified version.

Recovering Several Files at Once
In this tutorial, you will delete several files and recover them by creating a GoBack Drive, a virtual drive
that shows your drive as it was in the past.

1 Delete some of the files in the My Documents folder. As with the other tutorials, if you want, you 
can make a backup copy of the files in the My Documents folder before you begin.

2 Empty the Recycle Bin (right-click Recycle Bin then click Empty Recycle Bin from the shortcut 
menu). At this point, the files you deleted are, for the most part, irretrievable.

3 Open the GoBack Main Menu.
4 On the GoBack Main Menu, click the button labeled Revert your entire hard disk to a time in 

the past, or view your hard drive as it was before. This will open the GoBack Drive Window.
5 If you have more the one hard disk, make sure the disk that contained the deleted files is 

selected in the File menu.
6 Near the end of the event list (you may need to use the scroll bar on the right side to scroll to the 

end) you should see several entries in a row that show your files being moved to, and then 
deleted from, the Recycle Bin.

7 Above those entries, there should be a System Safe Point. Click to select that safe point. This is
the point in time before you deleted the files and when GoBack considered the hard drive "safe."

8 Click the Create GoBack Drive button at the bottom of the window. A GoBack Drive – a virtual 
drive – is created showing what your real hard drive looked like at the time you selected. When a 
GoBack Drive is created a message box appears, indicating what drive letter was assigned to it.

9 You can now use Windows Explorer to view the GoBack Drive. In Windows Explorer, open the 
My Documents folder on the GoBack Drive. The files you deleted previously should be visible 
there.

10 To recover the files, drag them from the GoBack Drive to your real hard drive (you can also use 
the cut-and-paste capability in Windows Explorer).

11 After you have recovered the files, you can return to the GoBack Drive Window and click the 
Discard GoBack Drive button to get rid of the GoBack Drive.



GoBack Boot Screen
There are three primary services provided through the Boot Screen, the ability to: perform an 
emergency revert of the hard disk, boot up from a floppy disk, and disable GoBack.
With GoBack installed, each time you boot your computer the GoBack Boot Screen will appear before 
that of the operating system. By sitting between your hard disk and the operating system, GoBack lets 
you, among other things, revert your hard disk back in time to undo catastrophic software failures and 
restore crashed systems. 

The GoBack Boot Screen appears briefly during your computer’s start up. You are given several 
seconds during which you can press the spacebar to access the emergency recovery functions of the 
GoBack Boot Menu. If you do not press the spacebar, the computer will start up normally.

If you are able to properly start up under the operating system, it is best to use Windows to access 
GoBack. However, in an emergency situation, you can revert your hard disk to an earlier state by using
the GoBack Boot Screen. Even if the revert point (the time in the past to which GoBack reverts your 
hard disk) is not ideal, after you start the Windows operating system successfully, you can use the 
other options in GoBack to revert to a better time.

If it appears that your computer has a physical 
hardware failure then it should be serviced before 
you attempt any data recovery. Repeated attempts to
recover using GoBack will use up your GoBack history
and may reduce the possibility of reverting your hard 
disk after the physical problems have been repaired.
The GoBack Boot Screen supports most mice. 
However, if the pointer for your mouse does not 



appear on screen, you will need to use the access 
keys (underlined letters) appearing in each command 
option. Press the underlined letter in order to select 
the option.

Using the GoBack Boot Menu
The actions available in the GoBack Boot Menu are described below: 

· Revert Drive: Activates the GoBack emergency recovery option. Use this when your PC is 
unable to boot up normally.

· Disable GoBack: You must disable GoBack if: you are using another operating system and wish 
to view all files across all drives; you are upgrading or reinstalling Windows; or you want to use 
disk-partitioning software.

· Boot from Floppy: This option is necessary only if you want to boot and run an application from 
a diskette and have access to your GoBack-protected hard disk(s).

· Continue: Select this option to proceed with the normal boot process of your system (from your 
hard disk).

· About GoBack: Select this option for information about GoBack.

Reverting Your Hard Disk
If your system fails to boot and you are unable to run Windows, use the GoBack Boot Menu to perform 
an emergency recovery – reverting your hard disk back to a time when Windows was operating.



When you choose to revert from the GoBack Boot Screen, GoBack recommends revert times starting 
with recent safe points. You can choose any of these points to revert your computer to a time 
corresponding to when it was working. If you are not successful with the first revert time, you can select
to revert again and choose a different time. Generally, the first one or two revert attempts will succeed 
in getting your computer’s operating system to boot.
If GoBack is not able to revert to a time that allows you to properly start your computer then you need 
to restore from your traditional backups. Keep in mind that a physical malfunction - like the 
microprocessor failing - will not be fixed by either GoBack or a traditional backup, however the data on 
your hard disk may not have been lost.

If it appears that your computer has a physical 
hardware failure then it should be serviced before 
you attempt any data recovery. Repeated attempts to
recover using GoBack will use up your GoBack history
and may reduce the possibility of reverting your hard 
disk after the physical problems have been repaired.

If you have more than one hard disk protected by GoBack, the revert back in time will affect all these 
disks.
To revert your hard disk from the GoBack Boot:

1 Restart your computer (use the power switch, the reset button, or press Ctrl+Alt+Delete).
2 When the GoBack Boot Screen appears, press the spacebar.
3 From the GoBack Boot Menu, click Revert Drive. GoBack will search your physical hard disk for 

safe times (when your hard disk was idle) to which to revert. GoBack identifies safe points and 
displays them in a dialog box (shown below). You can select a time and click Revert, click More 
Times to see other possible times, or cancel the revert request.

After you’ve selected one of the revert time options GoBack offers, your system will restart and 
try to boot. (Remember, do not press the spacebar the second time through the boot process.)

4 If your computer still does not start correctly, repeat Steps 1 through 3 and select a different time 
to revert to.

After your computer is able to start Windows, you can generally use the GoBack Drive Window to 
select a different time to which to revert your hard disk. The additional information provided in this 
window may be helpful in selecting a more desirable time.

Disabling GoBack
Occasionally, such as when you are going to change or upgrade operating systems or if you want to 
use disk-partitioning software (e.g., FDISK), you will need to disable GoBack. It is important to 
remember that whenever you disable GoBack, all the history GoBack has been tracking will be lost. In 
other words, you will not be able to revert your disk or retrieve old versions of a file prior to the time you
disable GoBack.
To disable GoBack from the GoBack Boot Menu:



1 When the GoBack Boot Screen appears, press the spacebar (you are given a few seconds). If 
you miss pressing the spacebar, restart your computer and try again.

2 Select the Disable GoBack button from the GoBack Boot Menu.
GoBack can also be disabled from the Options button in the GoBack Main Menu.

Re-enabling GoBack
If you have disabled GoBack, either through Windows or from the Boot Screen, each time you try to 
access GoBack in Windows (via the Start menu or the GoBack icon on the taskbar), you will be 
reminded that GoBack is disabled. You will then have the option to enable GoBack. GoBack can only 
be enabled from Windows.

Booting from a Floppy Disk
With GoBack installed and enabled, it continuously monitors all access to your hard disk. For those 
programs that require that you start your computer with their special boot disk, GoBack provides a 
feature that lets you boot from a floppy disk and still have the protection of GoBack. If you do not use 
the following procedure, you will still be able to boot from your floppy, as long as it does not need to 
access your hard disk.

To boot from a floppy disk:
1 Start the computer without the floppy disk in the drive.
2 When the GoBack Boot Screen appears, press the spacebar. The GoBack Boot Menu appears.
3 Insert your program’s floppy disk in the floppy drive.
4 From the GoBack Boot Menu, select Boot from Floppy. Your computer will now boot from the 

floppy.



GoBack Main Menu
From the GoBack Main Menu, you can access nearly all of the capabilities of GoBack: creating a 
GoBack Drive, recovering an old version of a file, and reverting your entire hard disk to the way it was 
in the past.
To open the GoBack Main Menu, select GoBack from Programs in the Start Menu, click the GoBack 
icon in the taskbar, or double-click the shortcut on your desktop.

GoBack Main Menu 

 

View a Presentation to Learn More
Click this button for an informative overview with a description of what GoBack 
does and examples of when and why you would use GoBack.

 

Revert an Entire Hard Disk or Create a GoBack Drive 
Click this button to open the GoBack Drive Window, where you can create a 
GoBack Drive or revert your hard drive to a time in the past.

 

Recover a Deleted or Old Revision of a File
Click this button to open the GoBack File Recovery Window, where you can find,
view, and recover old versions of your files.

þ I would like assistance with this task
When this option is selected, help will be displayed on the subsequent windows. If you do not wish to 
see online help, click this option to remove the check mark.

GoBack Options



The GoBack Options dialog, accessible by clicking the Options button on the GoBack Main Menu, lets 
you modify settings and features in two areas: History and Internet.

History tab
In the History tab you can Clear GoBack history for the drives selected in the list or 
Disable GoBack.

 
GoBack History Options Dialog

· Clear GoBack History
To prevent anyone from seeing what has been on your computer you can click Clear the 
GoBack History. Keep in mind that by clearing the GoBack History you also take away your 
own ability to go back in time. After the GoBack History has been cleared, it cannot be 
restored.

· Disable GoBack
To disable GoBack, click the Disable GoBack button. When you disable GoBack it also clears 
the GoBack History.

Internet tab
The Internet tab contains options relating to the Web Update feature that allows GoBack to 
automatically check the Internet for important updates. If your computer has an Internet connection, 
this option is enabled by default. The Periodically check… check box lets you turn this automatic web 
checking on or off. To open the browser and view the latest update on the GoBack web site, click 
View Updates.



 
GoBack Internet Options Dialog



Accessing GoBack using the Taskbar
To access the GoBack Main Menu, click the small GoBack icon in the status area of the taskbar. 
Alternatively, you can right-click the icon to open a shortcut menu and go directly to one the main menu
options.



GoBack Drive Window
You can access nearly all GoBack features from the GoBack Drive Window. You can see a list of all of 
your computer’s hard disk activities and select times to go back to using the clock, the calendar, and 
the Event List. After you select a time, you can either create a virtual GoBack Drive showing your hard 
disk at that time, or you can revert your entire hard disk to the selected time. 

To open the GoBack Drive Window, click the Revert your entire hard disk to a 
time in the past, or view your hard drive as it was before button from the 
GoBack Main Menu.



What is a GoBack Drive?
A GoBack Drive is a virtual copy of your hard disk as it appeared at a selected point in the past. A 
GoBack Drive lets you view or retrieve old (deleted or modified) versions of files or documents. The 
virtual GoBack Drive is constructed from information collected by GoBack while monitoring hard disk 
activity.
When you create a virtual GoBack Drive, GoBack effectively creates a copy of your hard disk as it was 
at a specific point in time. GoBack will automatically discard a virtual drive if the historic data on which 
is based becomes unavailable. This situation occurs when you continue to use your hard drive while at 
the same time maintaining a virtual drive. After you’ve created a virtual GoBack Drive and retrieved the
desired files, it is best to discard it. Should a GoBack Drive be automatically discarded and you attempt
to access the GoBack Drive, a "blue screen" error message may occur.
If you do not plan to discard your virtual GoBack Drive right away, you can get an idea for how long you
will be able to view the contents of the virtual drive. Compare how far back in time the virtual drive was 
created with how far back GoBack can see (using the calendar). For example, if GoBack can see back 
one week in time and you create a virtual GoBack Drive looking back one day, it is unlikely that this 
drive would be automatically discarded in the near future. However, if you create a virtual GoBack 
Drive looking back near the end of GoBack’s reach (in this example, one week), then you could lose 
your virtual GoBack Drive at any time. In these situations, you should consider immediately backing up 
any desired files (e.g., to a floppy disk).



The GoBack Drive Window
GoBack can bring the past forward. Now, you can retrieve data or system information and bring it back 
into the present. Through the GoBack Drive Window, and using the time and date you select, GoBack 
reconstructs the state of your hard disk using the current disk image and notes it has made along the 
way.



Selecting What to View
As you are looking at the GoBack Drive Window, you can view your hard disk’s activities over the past 
several days. The bold numbers on the calendar indicate the days that you can view. The event list 
shows you various events that occurred on your computer for the currently selected day. Use the 
calendar to view different days in the Event List. You can also filter the event list so that you only see 
the types of activities that are of interest to you.
You may select events directly from this list by clicking the desired item. The clock automatically 
remains synchronized with the highlighted selection in the Event List. The clock can be used to position
the Event List to a specific point in time. Enter a specific time in the area beneath the clock and press 
the Enter key. Remember to indicate AM or PM. The Event List will be updated to show the events 
closest to the time that you select.
You may view or revert your hard disk to a point in time corresponding to a Safe Point or Windows Boot
Point event in the list. Safe points are automatically created whenever your computer is idle for several 
seconds. As selectable points in time, they generally prevent you from accidentally choosing a time 
that is right in the middle of disk activity (for example, saving a word processing document). Accessing 
such a point in time would typically yield useless transitional data, so GoBack tries to avoid them.

Selecting a Drive
The GoBack Drive Window will initially show the first physical hard disk on your computer. If you wish 
to view a different disk, select it from the File menu.

Selecting the Date
Dates for which you can view events appear in bold on the Calendar. Clicking on a date will cause the 
Event List to update with the activity for that date. The date being viewed is highlighted on the calendar.
You can click the left and right arrows to scroll to the previous and next month in which there are 
events available to view.

Selecting the Time
The clock in the GoBack Drive Window provides another way to make a selection from the Event List. 
When you type a time into the space under the clock and press Enter, it will select the safe point event
from the Event List that is closest to the time you entered.



Working with the Event List
The Event List is the primary feature of the GoBack Drive Window. It allows you to review your system 
activity to help you find useful times to which to view or revert your hard disk. For example, it might 
show you when you launched programs or modified files. You can scroll through the Event List to view 
the logged events for the currently selected day. If you have more than one physical drive, you can 
view any other drive(s) and their partitions by selecting the desired drive letter from the File menu.

It may be helpful to filter the events (from the View menu) shown in the listing. You can also search for 
particular events by using the Find File or Note option in the Edit menu.

There are several types of events shown in the event list, identified by the following icons:

The GoBack logo marks GoBack activity, such as system boots and disk reverts.
A Safe Point icon indicates a point in time when there was not any system activity.
This icon identifies events relating to system activity such as Windows startup and
shutdown points.
This symbol identifies activities related to files (such as documents, spreadsheets,
etc.). There are numerous types of file activity, such as create, rename, and 
delete. If the name of a file is changed, both the old and the new names will be 
shown.
This icon identifies user events, such as user added notes.
This icon designates shell execute events such as files opened or printed from 
Windows Explorer, or programs or files run from the Start/Run dialog.

Filtering the Event List
The Filters feature in the View menu "filters out" folders or files of specified types from the Event List. 
The default filter list excludes temporary and Windows folder activity and .bak and .tmp file types. Note 



that filtering has no effect on the collection of information or your ability to recover it. It just modifies 
what you see when you view the Event List.
There are two filtering options available in the View menu:
· Use Filters: Click to toggle filtering on and off. A check indicates that filtering is active and events 

may be omitted from the Event List.
· Edit Filters: Select this option to specify the file extensions and/or folders you wish to omit from 

the Event List. 

You can "add" items to both folder and file extension filters. Be sure you understand that although you 
are selecting "Add," the effect is to "remove" the items from view. In other words, you are adding to a 
list of not-viewed items. 
You might want to filter out file extensions or folders that are not used for recovery purposes.    For 
example you might want to filter out your temporary Internet files, or files with the 
extensions .dll, .exe, .hlp, .gid, .dat, .ffa, .ffl, and .ffv. Folders not needed for viewing might also be 
~MSSETUP or recycle. Filtering these out of the Event List can make it easier to find a specific item 
you want to recover.

To add an item to the filter list:
1 Click Add in the File Filters dialog box (the upper block displays folders; the lower block displays 

file extensions). A dialog box will appear and allow you to enter the specific folder or file type you 
wish to filter out from viewing.

2 When you have entered the folder or file type to filter out, click OK.

To edit an item in the filter list:
1 In the File Filters dialog box, select the folder or file type you wish to edit.
2 Click the Edit button to the right of your selection. A screen will appear to let you edit the selected

item.
3 After you have made your changes, click OK.

To delete an item from the filter list:
1 In the File Filters dialog box, select the folder or file type you wish to delete from the list.
2 Click the Delete button to the right of your selection.

You can also edit filters by right-clicking on a file event in the GoBack Drive Window and selecting Hide
Events in this Folder or Hide Events of this File Type from the pop-up menu. The events you’ve 



hidden in this manner can be changed using the File Filters dialog box.

Selecting Events
You can click on any event in the Event List. However, if you intend to create a GoBack Drive or revert 
your disk you must select a safe point event. If you find a file event, such as a file modification, there 
are typically two safe points you can select. The safe point event that appears just after the file event 
corresponds to a point in time after the modification. Similarly, the safe point that appears prior to the 
file event corresponds to a time before the file was changed.

Finding a File or Note
To look for a specific file or note, choose the Find File or Note option from the Edit menu or press 
Ctrl+F. The Find File or Note option is used to perform a text search of file event and note entries in 
the Event List. Enter any part of the file name, folder, or extension or a portion of the note. The search 
is limited to the currently selected day. Select whether you wish to search down or up relative to the 
current position in the Event List. By default, the search direction is down. Searches are subject to 
filtering.



The Drop-Down Menus
Each GoBack window has several drop-down menus. Many of these functions are available using the 
command buttons or by clicking with the right mouse button while the pointer is on the appropriate part 
of the view.
The drop-down menus in the GoBack Drive Window are described below:

The File Menu

Drive C: and D: (If your computer has different hard drive letters, your File menu may appear different 
than pictured here.) A list of your physical disks is at the top of the menu (indicated by the logical drive 
letters assigned to it - see glossary for definitions of logical and physical disks). Click on a physical disk
to view its event log. If you only have one physical disk, no other selection is possible.
Create GoBack Drive at Selected Event: Creates a GoBack Drive based on the time you’ve selected
in the GoBack Drive Window using the Calendar and either the Clock or Event List.
Discard GoBack Drives: After you are done with a GoBack Drive you should discard it by selecting 
this option. You will see a screen message indicating that the GoBack Drive has been discarded and 
that the information is no longer accessible (without creating a new GoBack Drive). If multiple GoBack 
Drives were created because your physical disk consists of more than one logical drive, then all the 
GoBack Drives are discarded.
Revert Drives: Reverts your hard disk to the way it was in the past, based on the time you selected in 
the Calendar and the Event List or Clock. Select this option to revert all the drives on the selected 
physical disk to the way they were at the selected time. You must select a Safe Point or GoBack event 
for the revert.
Exit: This closes the GoBack Drive Window.

The Edit Menu

Add Note to Log: This feature lets you add a note of your own to the Event List. For example, if you 
are going to install a major application or work on important documents, marking the list prior to these 
activities can make earlier events easier to find. The note is added to the bottom of the list, like any 
new event. Adding a note does not constitute a selectable safe point (i.e., you cannot necessarily go 
back to exactly the time at which the note was added).
Find File or Note: This option is used to perform a text search in the Event List and is described in the 
previous section on Finding a File or Note.
Find Next: This will continue the previous search to the next match.

The View Menu



Filters allow you to narrow down the list of files presented in the Event List. The Use Filters option can 
be toggled on and off by clicking on it. When the check mark is visible, the filters are ON. For additional
information about filters, see the previous section on Filtering the Event List.

The Help Menu

Contents: This option opens GoBack Help.
GoBack Drive Help: This option provides help with the GoBack Drive Window.
What’s This?: To see a screen tip for a command button or screen region, click this option and then 
click the element you want information about.
Adaptec on the Web: After connecting to your Internet Service Provider, use this to access Adaptec 
on the Internet.
About GoBack: The version number of GoBack is indicated here. If you need technical assistance, it 
is important to have this number available.



The Command Buttons
The command buttons appear at the bottom of the GoBack Drive window. These are described below.

GoBack Menu: Displays the GoBack Main Menu.
Revert Drive: Reverts your hard disk to the way it was in the past, based on the time you selected. 
This option is equivalent to the Revert Drives option on the File menu.
Create GoBack Drive: Creates a GoBack Drive based on the time you selected in the GoBack Drive 
Window using the calendar and either the clock or event list. This option is equivalent to the Create 
GoBack Drive at Selected Event option on the File menu.
Discard GoBack Drive: This option discards a previously created GoBack Drive. This option is 
equivalent to the Discard GoBack Drives option on the File menu.



Alternative Methods to Enter Commands
In addition to making selections using the drop-down menus and the command buttons, there are 
several places where you can click the right mouse button to initiate an action.

Using the Right Mouse Button
Clicking on the right mouse button will display a list of options appropriate to each screen, depending 
the location of your pointer when you right-click. If there is no option available at the location you’ve 
selected, you are presented with a "What’s This?" dialog as if you had selected it from the Help menu.



GoBack File Recovery Window
With the GoBack File Recovery Window, you can recover earlier versions of files, including files that 
have been over-written or deleted. The GoBack File Recovery Window allows you to select the file you 
wish to recover and the folder location in which to save the recovered file. Alternatively, you may 
directly open a file from the past. This causes the file to automatically be restored and the appropriate 
application launched to view it. In this case, the recovered file is stored in a temporary folder and is 
write-protected, anticipating that you will save it elsewhere if you wish to keep it. These files are 
automatically discarded on system shutdown. Thus, while viewing a file directly opened from the past, 
if you wish to save it, you should do so promptly.

To open the GoBack File Recovery Window, click the Recover a deleted file or 
get back an earlier version of a changed file button from the GoBack Main 
Menu.



Selecting What to View
If you have more than one hard drive in your computer then in order for GoBack to display the 
information that you need in order to recover a file, you must select the drive on which your file is 
located.

Selecting a Drive
The GoBack File Recovery Window will initially show the first drive on your computer. If you wish to 
view a different drive, select it from the File menu.



Working with the File List
The File List contains all the files that GoBack can recover. If you know what you are looking for, you 
can sort the list by clicking on any of the column headings.

The column headings include:
· Name: The names in this column are the original names of files that GoBack can recover.
· Size, Type: These columns help you identify the different versions of the files.
· Location: This shows where each file was originally saved.
· Original Time: This is the time that each file was originally created.
· Modified Time: This is the last time that each file was modified, and corresponds to when they 

were added to the list.

Sorting the File List
Initially the list is sorted in reverse order by Modified Time, with most recent versions at the top. You 
can click on each of the column headers to sort the list according to that column. By clicking on the 
column heading a second time, you can switch between ascending and descending order.
It is possible that some dates are initially out of order in the list. This occurs when an application 
modifies a file and then sets the modified date back.

Locating Files
To locate a file, type all or part of the file name into the Locate Files Matching text box then click 
Locate Now. This changes the file list to show only files with names that contain the text that you 
entered. To again view the complete list, click Locate All.

Selecting Files
After you select a file, you can either restore the file or directly open it. You cannot restore multiple files 
in one operation. In this situation you should consider creating a GoBack Drive that reflects the disk at 
some point in the past and using Windows Explorer to copy files across to your main disk. This process



is faster for recovering large groups of files.



The Drop-Down Menus
Each GoBack window has several drop-down menus. Many of these functions are also available using 
the command buttons or by clicking with the right mouse button while the pointer is on the appropriate 
part of the view. The drop-down menus in the File Recovery Window are described below.

File Menu

(C:): This option indicates and lets you change the drive selected for viewing recoverable files. 
Depending on your computer’s hard drive configuration, drive names may be different than shown in 
the illustration. To change drives, click the letter of the drive for which you want to recover files. In the 
illustration above, the main drive is currently selected.
Open: After you select a file in the File List, this option opens the file for viewing.
Recover Selected File To: This option lets you recover and specify a place to save a selected file. By 
default, the file is saved to its original location. You may wish to select an alternate location in order to 
avoid overwriting the current version of the file.
Refresh: Select this option to update the list of recoverable files, reflecting any changes since you 
opened the window. In other words, after you open the window the list remains fixed. Continued 
system activity may make the list somewhat obsolete and therefore you may need to refresh it. 
Exit: This closes the GoBack File Recovery Window.

Edit Menu

Find File: This option displays a standard Find dialog where you can enter all or a portion of the name 
of the file you are looking for. If a match is found, the file list will scroll to the first occurrence.
Find Next: This option repeats the previous find request starting from the current location in the list.

Help Menu

Contents: This option opens GoBack Help.
GoBack File Recovery Help: This option provides help with the GoBack File Recovery Window.



What’s This?: To see a screen tip for a command button or screen region, click this option and then 
click the element you want information about.
Adaptec on the Web: After connecting to your Internet Service Provider, use this to access Adaptec 
on the Internet.
About GoBack: The version number of GoBack is indicated here. If you need technical assistance, it 
is important to have this number available.



The Command Buttons
The command buttons appear at the bottom of the GoBack File Recovery window. These are 
described below.

GoBack Menu: Displays the GoBack Main Menu.
Open: With a file selected, click Open to view it. This is equivalent to the Open option in the File menu.
Recover To: Click this button to recover the selected file. This is equivalent to the Recover Selected 
File To option in the File menu.



GoBack in Windows Explorer
GoBack can be used through Windows Explorer to provide a quick and easy way to retrieve or view 
older versions of a file. Technically, GoBack is providing a shell extension to Windows Explorer. A 
recovered file can replace your existing document or be saved with another file name.



The GoBack Shell Extension
The GoBack Shell Extension lets you access GoBack through Windows Explorer and provides a quick 
way to view or retrieve old versions of files. After opening Windows Explorer, (Select Start then 
Programs then Windows Explorer) locate the file that you want to see the revisions of and right-click 
it. A pop-up menu will appear:

GoBack Shell Extension in Windows Explorer

To see all the old versions of your file that GoBack has maintained, click Show Revisions next to the 
GoBack logo. A dialog box similar the following illustration will appear:



The example above shows that two versions of the file "swinventory.xls" can be retrieved or viewed.



Working with the File Version List
The file version list will include all copies (within the time period GoBack is able to record) of a 
particular file. The list will display the original file name (as it may have been renamed) along with the 
its size and the time at which it was originally saved.

Sorting the File Version List
Initially the list is sorted by Original Time, with most recent versions at the top. You can click on each of
the column headers to sort the list according to that column. By clicking on the column heading a 
second time, you can switch between ascending and descending order.

Selecting Versions of the File
From the File Version List, you may select one of your old versions. You can then select Open to view 
the file (and then possibly Save As something else) or Recover to will recover the file without opening 
it first. Note that the entry at the top of the list corresponds to the current version of the file (not an older
one). 
For step-by-step instructions, see Frequently Asked Questions.



The Command Buttons
Recover To: Click this button to save the selected file.
Open: Click this button to open the selected file.
OK, Cancel: Clicking on OK or Cancel will remove you from this window.



Frequently Asked Questions (FAQs)
This section is designed to answer your questions with simple, easy-to-understand answers. jumps to 
sections relevant to the questions are also provided so that you may refer to the more detailed 
information and pictures provided there.

How far back in time can GoBack retrieve data?
The length of time over which GoBack can recover data is determined by the amount of hard disk 
space allocated to GoBack and the intensity of computer usage. You can usually recover files for 
several days and possibly for several weeks. It all depends on how much data you are changing and 
how frequently it is changed. For example, programming and intense work with large graphics will use 
the space allocated to GoBack faster than word processing, or working in spreadsheets. With today’s 
hard disk drives becoming larger and less expensive, allocating part of your hard disk for GoBack will 
almost certainly lead to meaningful recovery ability.
You may wish to periodically check how far you can reach back in time (using the GoBack Drive 
Window) and adjust the allocated GoBack area accordingly. More space translates to a greater reach.
If massive amounts of data are altered, it is possible that your recovery ability will be limited, if 
available at all. After normal usage resumes, your recovery ability will usually start just after the 
massive change. For example, if at installation time, 200 megabytes of disk space is set aside for 
GoBack, and subsequently 200 megabytes of data is loaded in a short period of time (like from CD-
ROM), you will lose your recovery ability at that point in time. However, if you continue working and 
alter a one megabyte file every ten minutes, working eight hours a day, you will be able to look back as 
far as four days to any overwritten version of a file.
It is recommended that you continue to periodically back up your hard disk to protect against your hard 
disk actually breaking (physical hardware failure) as well as ensuring that you have complete 
snapshots of your data from specific points in time that will eventually be out of GoBack’s reach. 

What is MS-DOS Compatibility mode?
MS-DOS Compatibility mode is a mode in Windows 95/98/Me in which your hard disk(s) are not 
operating optimally using Windows 32-bit drivers, but are instead using MS-DOS real-mode drivers.
If GoBack detects this condition, GoBack will not install or run. You must correct the problem before 
running GoBack.
There can be many reasons that a hard disk is running in MS-DOS Compatibility mode. These reasons
include, but are not limited to:

· An "unsafe" device driver, program, or virus loaded in Windows memory.
· A hard disk controller not detected in Windows.
· A conflict between the hard disk controller and another device.
· An incompatible hardware device or configuration in Windows.
· A damaged Windows driver.

Because GoBack does not cause the MS-DOS Compatibility mode condition, you must consult your 
hardware manufacturer for information about correcting the problem. You can also find many detailed 
articles about troubleshooting MS-DOS Compatibility mode problems in the support area on the 
Microsoft web site.

What happens when I upgrade my operating system?
GoBack connects into the operating system at a very low level. Like virus checking software, GoBack 
should be disabled before upgrading the operating system. This is also true if you should need to 
reinstall your operating system.
If you wish to use an operating system for which there are no GoBack Drivers, and you wish to access 



the parts of your physical drive used for Windows, then you must disable GoBack first. Note that this 
defeats all of the GoBack monitoring and protection services and causes GoBack to discard all of the 
information regarding your system that it has stored so far. When you are done accessing the physical 
drive from outside Windows, you can re-enable GoBack. You can disable GoBack through the Main 
Menu/Options. 

During an upgrade, your computer may be rebooted 
multiple times. Each time you will be asked if you 
want to re-enable GoBack. Select No until you have 
completed the final portion of the upgrade or 
reinstall. On your next restart, you may then re-
enable GoBack for system protection.

Do I still need to make backups?
Yes. GoBack complements a traditional backup by providing recovery ability to virtually any point within
GoBack’s reach (typically, a week). It provides a window to your recent past to which you can easily 
jump back. You do not need to stop and make a traditional backup, in order to have this window 
available to correct a mistake. However, GoBack does not prevent data loss if your hardware actually 
breaks (e.g., if your disk drive breaks down) or if the data you desire was altered long ago. This is 
where a traditional backup comes into play. Thus, GoBack complements your current backup process.
Remember, whether by way of a traditional backup, or going back in time using GoBack, the basic 
purpose of being able to restore data is to reduce the chances of having to spend a lot of time re-
creating the information. The harder it would be to re-create important work, the stronger the steps you 
should take to protect it. It is common, for extremely valuable information, to not only make a traditional
backup, but to make several, and place them at various off-site locations (e.g., in case of fire).

Will GoBack affect my computer’s speed?
In general, GoBack does not significantly impact your computer’s overall performance. Writing to your 
hard disk should take about the same amount of time, regardless of whether GoBack is installed or not.
The work GoBack does in order to provide the ability to go back in time is generally done in the 
background. If you are loading or modifying very large files (in relation to the disk space set aside for 
GoBack) such that useful recovery is no longer possible, GoBack automatically steps aside during this 
period and then resumes tracking as soon as possible.

How does GoBack determine where to put Safe Points?
GoBack continually monitors all hard disk activity, and when it determines that nothing has been written
to the hard disk for several seconds, it makes a note (a Safe Point) in its log. When you want to revert 
your hard disk, create a GoBack drive, or recover a file, GoBack allows you to select these safe times, 
because you generally wouldn’t want to choose a time when you were in the middle of saving a file.
It’s important to note that if you perform several file activities in rapid succession, such as writing a file 
and then immediately deleting it, GoBack may not have written a Safe Point in the log. If this happens, 
you may not be able to select a time between these activities. To avoid this situation, pause between 
disk activities to allow the hard disk time to catch up.

How do I adjust the amount of space allocated to GoBack?
In order to make adjustments to the installation of GoBack, such as the amount and location of disk 
space allocated to GoBack, you must uninstall then re-install GoBack. Note that this will reset the 
information that GoBack has been tracking (GoBack History) and you will not be able to retrieve or 
revert back to the time before the uninstall.

How do I prevent others from looking at files that I have deleted?
If you work with confidential data or do not want others to be able to look at your hard disk as it was in 



the past, you can delete the data that GoBack has been collecting. Keep in mind, that after the GoBack
History has been cleared, you can no longer view or retrieve data before this time.
To clear the GoBack History:

1 Open the GoBack Main Menu.
2 Click the Options button.
3 Select the drive(s) you’d like to clear.
4 Click the Clear GoBack History button.

How do I view my hard drive as it appeared in the past?
See: How do I create a GoBack Drive?

How do I create a GoBack Drive?
For more information on GoBack Drives, including 
pictures of the GoBack Drive Window, see section 
"GoBack Drive Window."

The following steps re-create a "copy" of a drive at the time of a selected event:
1 First, open GoBack by doing one of the following:

· Select Start, then Programs, then GoBack 
· Click the GoBack icon in the taskbar.
· Right-click the GoBack icon in the taskbar, then select one of the main GoBack 

functions from the pop-up menu.
· Double-click the GoBack shortcut on the desktop (if available).

2 At the Main Menu, click the Revert your entire hard disk to a time in the past, or view your 
hard drive as it was before button. The GoBack Drive Window opens.

3 From the File Menu, select the physical disk (one of your hard disks) from which you want to 
create the GoBack Drive(s). 

4 In the Event List, select the Windows Boot Point or System Safe Point on which to base the 
creation of the GoBack Drive. If the date that you wish to revert to does not show in the event list,
either click on the appropriate date in the calendar or use the scroll bar to move the list up or 
down. Also, if you know the approximate time you wish to go back to, you can type the time 
under the clock, which will move the Event List to the safe point nearest to the time you typed.

5 Click the Create GoBack Drive button. A message box will appear indicating the drive has been 
created. A red box will appear around the date and the event from which you created the GoBack
Drive. The GoBack Drive(s) will appear as an additional drive(s) in Windows Explorer.

6 Use Windows Explorer to access files on the GoBack Drive(s).
In Windows Explorer, the letter which follows the word "GoBack" indicates the original drive 
(based on the selected event) which was used to create the GoBack Drive. The drive in 
parentheses is the designation for the GoBack Drive.

How do I get rid of a GoBack Drive that I created?
After you have finished looking at or retrieving data from the virtual GoBack Drive you created, you 
should delete the GoBack Drive to save system resources.

1 Open GoBack by doing one of the following:
· Select Start, then Programs, then GoBack 
· Click the GoBack icon in the taskbar.
· Right-click the GoBack icon in the taskbar, then select one of the main GoBack functions 

from the pop-up menu.



· Double-click the GoBack shortcut on the desktop (if available).
2 From the GoBack Main Menu, click the Revert your entire hard disk to a time in the past, or 

view your hard drive as it was before button. The GoBack Drive Window will appear. If your 
system includes multiple physical disks, the GoBack Drive(s) that will be discarded are for the 
currently selected disk as viewed in the Event List. If you wish to discard a different disk, select it 
in the File menu.

3 Click the Discard GoBack Drive button. A message box will indicate the drive(s) has been 
discarded.

How do I get back a deleted or overwritten file?
There are several ways to recover files using GoBack; two of them will be covered here. See sections 
"File Recovery Window" and "GoBack in Windows Explorer" for additional details and pictures.

To Recover Files using the GoBack Main Menu:

1 Open GoBack by doing one of the following:
· Select Start, then Programs, then GoBack 
· Click the GoBack icon in the taskbar.
· Right-click the GoBack icon in the taskbar, then select one of the main GoBack functions 

from the pop-up menu.
· Double-click the GoBack shortcut on the desktop (if available).

2 At the GoBack Main Menu, click the Recover a deleted file or get back an earlier version of a 
changed file button. The GoBack File Recovery Window will appear.

3 From the File menu, select the hard disk your file is located on.
4 Select a file version from the list then:

· To recover the file, click Recover To, and select a title and location for this recovered 
version. If you do not wish to replace your current version, be sure that you have selected 
either a different title or a different location for this recovered version.

· To view the file, click Open. The file is brought back from the past and stored in a temporary 
folder in Adaptec\GoBack\Temp. The appropriate application is then automatically launched
to view the file. If it turns out that this is the version of the file you were looking for select File,
then Save As, and specify a name and location for this version. Upon exiting the application 
you will return to the Revisions dialog box at which point you may view another version.

To Recover Files Using Windows Explorer (the Shell Extension):

1 From the Start menu choose Programs and then Windows Explorer.
2 Click on the drive containing your document.
3 Open the folders (and subfolders if needed) until you see the file you wish to view.
4 Right-click on your selected file.
5 On the pop-up menu, click Show Revisions.
6 Sort the resulting dialog box, if necessary, by clicking on the column heading by which you wish 

to sort.
7 Select a file version from the list, then:

· To recover the file, click Recover To, and select a title and location for this recovered 
version. If you do not wish to replace your current version, be sure that you have selected 
either a different title or a different location for this recovered version.

· To view the file, click Open. The file is brought back from the past and stored in a temporary 



folder in Adaptec\GoBack\Temp. The appropriate application is then automatically launched
to view the file. If it turns out that this is the version of the file you were looking for select File,
then Save As, and specify a name and location for this version. Upon exiting the application 
you will return to the Revisions dialog box at which point you may view another version.

How do I revert my hard disk?
There are two ways to revert your hard drive. See sections "GoBack Boot Screen" and "GoBack Drive 
Window" for more information. One method is outlined below:

1 Open GoBack by doing one of the following:
· Select Start, then Programs, then GoBack 
· Click the GoBack icon in the taskbar.
· Right-click the GoBack icon in the taskbar, then select one of the main GoBack functions 

from the pop-up menu.
· Double-click the GoBack shortcut on the desktop (if available).

2 From the Main Menu, click the Revert your entire hard disk to a time in the past, or view 
your hard drive as it was before button. The GoBack Drive Window will appear.

3 In the File menu, click the disk to be reverted.
4 On the Calendar, click on the date to revert the disk to. You can click on the arrows to change 

which month is displayed. If the date you wish to select is gray, then GoBack does not have any 
information for that date and is unable to revert to that date.

5 Select the time from which to revert the disk to:

If you know what time to retrieve the files from, click in the box below the clock, type in the time, 
and press Enter.

If you aren’t sure what time to revert to, you can use the Event List to help you determine what 
you were doing at the time. After you find the appropriate time, click on the System Safe Point 
nearest to that time.

6 Click the Revert Drive button. GoBack will need to restart your computer to complete the revert 
process.

How do I get back files after I’ve reverted my hard disk?
If you’ve reverted your drive and realize that you no longer have one or more files you were working 
on, you can generally retrieve them using GoBack. You may use the File Recovery Window or create a
GoBack Drive. The later method is presented here. For more related information see the section 
"GoBack Drive Window."

1 Start GoBack and open the GoBack Drive Window.
2 If you are not viewing the drive containing the files to be retrieved, choose the correct drive from 

the File menu.
3 On the calendar, click the date from which to retrieve the files. You can click on the arrows to 

change which month is displayed. If the date you wish to select is gray, then GoBack does not 
have any information for that date and is unable to retrieve files from then.

4 Select the time from which to recover files. If you know what time to retrieve the files from, click 
on the box below the clock, type in the time, and press Enter. If you aren’t sure what time to 
retrieve the files from, you can use the Event List to help you determine what you were doing at 
the time. After you find the appropriate time, click on the safe point nearest to that time.

5 Click the Create GoBack Drive button. A new drive will appear in Windows Explorer.
6 Use Windows Explorer to find the files you wish to retrieve on the GoBack Drive and copy them 



to your normal drive.
7 Return to the GoBack Drive Window and discard the GoBack Drive.

How do I view all the recent versions of an MS Word document?
To view (and recover, if desired) your most recent versions of your Word document:

1 Open Windows Explorer by selecting Start, then Programs, then Windows Explorer.
2 Click the drive containing your document.
3 Open folders (and subfolders if needed) until you see the file you wish to view.
4 Right-click on your selected file.
5 On the pop-up submenu that appears, click Show Revisions.
6 Sort the resulting dialog box, if necessary, by clicking on the column heading you wish to sort by.
7 Select the version.
8 Click Open to view the file. This brings the file forward in time, saving it in a temporary folder, and

launches MS Word so that you may view the file. To save the file, select File, then Save As, and 
select a name and location. You may also click Recover To in order to save the file without 
viewing it.

For more information regarding this topic, see the section "GoBack in Windows Explorer."

How do I start my computer when it’s "locked up"?
When you are unable to start your computer normally, you can perform an emergency recovery from 
the GoBack Boot Screen. See the section "GoBack Boot Screen" for more information.
To revert your hard disk from the GoBack Boot Menu:

1 Restart your computer (use the power switch, the reset button, or press Ctrl-Alt-Delete).
2 When the GoBack Boot Screen appears, press the spacebar.
3 From the GoBack Boot Menu, click Revert Drive. GoBack will search your physical hard disk for 

safe times (when your hard disk was idle) to which to revert. GoBack identifies safe points and 
displays them in a dialog box. You can select a time and click Revert, click More Times to see 
other possible times, or cancel the revert request.
After you’ve selected one of the revert time options GoBack offers, your system will restart and 
try to boot. (Remember, do not press the spacebar the second time through the boot process.)

4 If your computer still won’t start correctly, repeat steps 1 through 3 and select a different time to 
revert to.

How do I use the floppy disk that came with a game or other program?
To boot from a floppy disk:

1 Start the computer without the floppy disk in the drive.
2 When the GoBack Boot Screen appears, press the spacebar. This brings up the GoBack Boot 

Menu.
3 Put your program’s floppy disk in the floppy drive.
4 From the GoBack Boot Menu, select Boot from Floppy. Your computer will now start booting 

from the floppy.
See the section "GoBack Boot Screen" for more information.

How do I disable GoBack?
There are a few occasions when you may want to disable GoBack:

· When you wish to boot up using an alternate operating system and be able to access files 



normally protected by GoBack. 
· Before upgrading your operating system.
· Before using disk-partitioning software to modify your disk partitions.

To disable GoBack from within Windows (see the section "GoBack Main Menu" for more information 
about the Options button):

1 From the GoBack Main Menu, select Options.
2 From the GoBack Options dialog, select Disable GoBack.

To disable GoBack from the GoBack Boot Screen (see section "GoBack Boot Screen" for more 
information regarding the Boot Screen):

1 Press the spacebar when the GoBack Boot Screen appears.
2 From the GoBack Boot Menu, select Disable GoBack.

Remember, GoBack will not track any information 
while it is disabled. The "Disable GoBack" option also 
clears all GoBack history so that you will not be able 
to revert any disks, view, or retrieve any old files 
from the time before GoBack was disabled.

How do I uninstall GoBack?
Be sure to use the uninstaller provided with GoBack. 
Do not use a third party uninstaller.

The following steps will remove the application from your hard disk and release all allocated storage on
all physical drives:

1 From the Start menu, select Settings, Control Panel.
2 In Control Panel, double-click the Add/Remove Programs icon.
3 At the Add/Remove Programs Properties dialog box, select GoBack from the list of installed 

applications and click the Add/Remove button.
4 Follow the on-screen instructions.

The system will reboot to complete the uninstall.

How do I use GoBack with other operating systems?
If you need to be able to access any of the drives that GoBack is protecting, then you must disable 
GoBack before using an operating system other than Windows 95, Windows 98, or Windows Me 
(Millennium Edition). If you do not need to access those drives, then it won’t hurt to leave GoBack 
enabled.

How do I use GoBack with MS-DOS?
GoBack can continue to protect your hard disk(s) while you run an MS-DOS-based window while still in
Windows. Note that GoBack may prevent some MS-DOS disk utilities from modifying protected areas 
of the hard drive.



Glossary

Boot Time
The initial period when your computer is starting is referred to as its boot time. If you restart your 
computer then a new boot is initiated.

GoBack Drive
A GoBack Drive looks and is used like any other drive (such as your floppy drive) but it is created by 
you using GoBack. Unlike a real drive, a GoBack Drive doesn’t really exist -- its contents are 
generated by GoBack based on the way your hard drive was as some selected time in the past. You 
can use a GoBack Drive to retrieve or just view earlier versions of your files.

Note that although you can write to a GoBack Drive, 
any changes will be lost when the drive is discarded 
(or Windows is shut down).

GoBack History
In order for GoBack to provide the ability to go back in time, it makes notes about changes occurring 
on your computer. These notes are stored in an area on your hard disk, which is referred to collectively 
as the GoBack History. The area and its size are established during installation.

Logical Drive
The result of partitioning a physical drive into separate, smaller drives. For example, one physical disk 
may be divided into two logical drives, C: and D:.

Physical Disk
This is the physical hard disk drive that is interfaced to your computer. Physical disks may be 
partitioned into one or more logical drives.

Recover
This is the process of retrieving a file that existed at some point in the past and saving it to the 
"present."

Revert
This is the process of changing an entire physical disk to the way it was at some point in the past. If 
there is more than one logical drive on the physical disk, all of the drives will be reverted 
simultaneously.

Safe Point
This is a moment in time that GoBack has determined the hard disk is "stable," meaning that all of the 
data on the hard disk is in a consistent state. Safe points are the times at which a GoBack Drive can be
created or to which a hard disk can be reverted.

Shell Extension
GoBack provides additional functionality to Windows Explorer through the standard means of a shell 
extension.

Virtual Drive



A "fake" disk drive created with software. GoBack Drives are virtual drives.

Windows Explorer
This application is provided with Windows operating systems. It lets you, among other things, view, 
copy, and delete files that are on the various hard drives connected to your computer.
 



Important Updates and Notices

All users of GoBack should read the following.

It is important to realize that, although GoBack adds an underlying safety net to the use of your 
computer, it is not a replacement for backups. In many situations, GoBack will be able to restore your 
entire computer or a specific file that would otherwise be lost. However, this ability should not be 
assumed. GoBack's restorative ability is a function, among other things, of the intensity of disk usage 
and the amount of disk space allocated for tracking. 

A tutorial about the unique features and abilities of GoBack can be launched from the GoBack Main 
Menu.

Should you wish to do so, GoBack can only be correctly uninstalled using Add/Remove Programs (click
Start, Settings, then Control Panel).

The following are important issues relating to the use of GoBack.

MS-DOS Compatibility mode
MS-DOS Compatibility mode is a mode in Windows 95/98/Me in which your hard disk(s) are not 
operating optimally using Windows 32-bit drivers, but are instead using MS-DOS real-mode drivers.
If GoBack detects this condition, GoBack will not install or run. You must correct the problem before 
running GoBack. There can be many reasons that a hard disk is running in MS-DOS Compatibility 
mode.

These reasons include, but are not limited to:
· An "unsafe" device driver, program, or virus loaded in Windows memory.
· A hard disk controller not detected in Windows.
· A conflict between the hard disk controller and another device.
· An incompatible hardware device or configuration in Windows.
· A damaged Windows driver.

Because GoBack does not cause the MS-DOS Compatibility mode condition, you must consult your 
hardware manufacturer for information about correcting the problem. You can also find many detailed 
articles about troubleshooting MS-DOS Compatibility mode problems in the support area on the 
Microsoft web site.

Drive support / device drivers
GoBack can protect all drives that are recognized by the BIOS. If your drive is not recognized during 
the initial BIOS hardware identification phase of the boot or requires special device drivers you will not 
be able to use GoBack with that drive. GoBack does not protect removable media, like diskettes, Zip, 
etc.

Using disk partitioning utilities
With GoBack installed you can still use partitioning utilities to manipulate your hard disk's partitions. 
However, before you use any of these utilities you must disable GoBack (from the GoBack Main Menu,
click Options, then Disable GoBack). After you have finished modifying your hard disk's partitions, re-
enable GoBack.

The following programs are known to modify disk partitioning: Partition Magic, Partition-It, Ontrack Disk
Manager, and EZ-drive.

Installing or moving hard disks



Before installing or moving a hard disk, disable GoBack (from the GoBack Main Menu, click Options, 
then Disable GoBack), install the drive, then re-enable GoBack. If you want GoBack to track the new 
hard drive's events you will need to uninstall GoBack (using Add/Remove Programs in Windows 
Control Panel) then re-install GoBack.

Operating system compatibility and upgrading
GoBack is compatible with all versions of Microsoft Windows 95, Windows 98, and Windows Me 
(Millennium Edition). This version of GoBack does not support Linux, OS/2, Windows NT, or Windows 
2000 (note: a Windows NT / Windows 2000 version of GoBack is forthcoming).

When upgrading to a new or different operating system, GoBack should first be uninstalled. An 
appropriate version of GoBack that supports the new operating system should then be obtained and 
installed.

Using disk compression utilities
GoBack is not supported on drives compressed with a disk-level compression utility (such as 
DriveSpace, DoubleSpace, etc.). However, GoBack is fully compatible with file-level compression, such
as that provided by PKZIP, WINZIP, and ARJ.

Booting from floppy disks
With GoBack installed you can still boot from floppy disks. However, you must ensure that GoBack 
drivers are loaded. These will allow you to access your hard disks. To boot from a floppy, start by 
booting your system from the hard disk. In other words, without yet inserting the floppy, restart your PC.
When the initial GoBack screen appears, press the spacebar, then insert your floppy disk and then 
click the Boot from floppy option.

More about "Safe Points" and file recovery
GoBack automatically creates "safe points" surrounding various events like saving a file. You can 
select a safe point either before or after an event in order to see your disk at these respective times. 
The file recovery systems in GoBack utilize safe points in order to retrieve otherwise lost files. GoBack 
requires about ten seconds of hard disk inactivity between operations (like saving a file) in order to 
distinguish the two events. Thus, if you save a file, quickly make a change and then save it again within
about ten seconds there is a chance that GoBack will not be able to recover the interim revision. 
However, revisions at earlier or later safe points are still recoverable.

GoBack is not a replacement for traditional backup program. However, if you have a non-hardware 
failure, GoBack will generally be able to save the day.

Disk activity, performance, and restorative ability
In most situations involving disk activity, such as saving a file, GoBack will not noticeably impact the 
computer's performance. However, it will add some background disk activity that is involved with re-
optimizing and ensuring your changes transition safely to the disk (part of its unique protection against 
data loss). If you have made many changes to your disk in a short amount of time, you may notice the 
added background disk activity. However, it will complete in time but, because it is done in the 
background, you can continue to use and/or shutdown your computer.

How GoBack works and the theory behind it
GoBack works by adding a protective level between the operating system and your hard disk. GoBack 
tracks all the changes that are made to the disk. It contains special logic to avoid data loss in the event 
of a sudden crash or power loss. Because it is keeping track of all your changes made in the recent 
past, it can reconstruct your disk at virtually any point - a "safe point" - in the recent past.

Safe points are moments in time where your disk is idle for about ten seconds. GoBack allows you to 
return your disk to an earlier state (reverting) or view and/or recover specific files from the past (by 



referencing back to moments when your disk was idle). Using a portion of the disk to track recent 
changes, it is very likely that GoBack can restore your computer to working order or retrieve an 
otherwise lost file. This ability is provided without generally impacting your computer's performance.



Open GoBack Drive Window

Selecting this option open the GoBack Drive Window so that you can create or discard GoBack drives.



Open GoBack File Recover Window

Selecting this option opens the GoBack File Recover Window so that you can recover deleted or 
changed files.



Open GoBack Revert Window

Selecting this option opens the GoBack Revert Window so that you can revert your hard disk to an 
earlier time.



View Presentation

Selecting this option will open a short presentation showing how to use GoBack.



Assistance

Enabling this option will result in a "Help" window appearing when you open the GoBack Drive Window
or GoBack File Recovery Window. This will walk you through the most common operations of the 
window.



GoBack Options

Displays a dialog with the option to disable GoBack or clear the GoBack history



Close

Exits from the GoBack Main Menu.



Drive List

Selecting the "Clear GoBack History" button will affect all of the drives highlighted in this list.



Clear GoBack History

This option will clear the GoBack History on each of the drives selected in the drive list.



Disable GoBack

This option will disable GoBack after restarting the computer.



Periodically check Internet for updates

With this option enabled, GoBack will periodically check the Internet for any important updates.



View Updates

This option will open your web browser and display any important updates at the GoBack web site.



Visit the Adaptec web site

This option will open your web browser and display the Adaptec web site.



Change Administrator Password

This option allows you to change the GoBack administrator password.



Change User Password

This option allows you to change the GoBack user password.



Old password

Enter the original password here.



New password

Enter the new password here.



Confirm new password

Enter the new password here for verification.



Enable Auto-Revert

Enabling this option will enable the Auto-Revert feature of GoBack.



Auto-Revert every day at

This option will cause an Auto-Revert to occur every day at the specified time.



Auto-Revert time

If the "Auto-Revert every day at" option is checked, this specifies the time the Auto-Revert will occur.



Read Auto-Revert schedule from file

This option will cause an Auto-Revert to occur at the times and days specified in the schedule file.



Schedule file

If the "Read Auto-Revert schedule from file" option is checked, this specifies the file to read the 
schedule from.



Browse for schedule file

This option allows you to browse for the Auto-Revert schedule file.



Auto-Revert Now

This option allows causes an immediate Auto-Revert to the Auto-Revert time.



Calendar

Selecting a date in the calendar determines what events will be shown in the event list.

Dates for which GoBack has information are displayed with bold numbers.

The selected date is displayed with inverted colors.

If a GoBack drive has been created, the date it is set to will be outlined in red.



Clock

The clock shows the time associated with the event selected in the event list.



Time Entry Field

Entering a time here will cause the event nearest that time to be selected in the event list.



GoBack and the GoBack logo are trademarks of Adaptec, Inc.



Event List

This is a list of events that have resulted in changes to the hard drive.

Safe points are times when the hard drive was in a stable state.



Revert Drive

This option will revert the current hard disk to the state it was before the selected event occurred.



Create GoBack Drive

This option will create a GoBack Drive showing the current drive in the state it was before the selected 
event occurred.



Discard GoBack Drive

This option will remove the GoBack Drive associated with the current drive. Any changes to the 
GoBack Drive will be lost.



GoBack Menu

This button will display the GoBack Main Menu.



File events in the listed folders will not appear in the event list if filtering is enabled.



This option adds a new folder to the filter list.



This option edits a folder in the filter list.



This option removes the selected folder from the filter list.



File events on files with the listed extensions will not appear in the event list if filtering is enabled.



This option adds a new file type (extension) to the filter list.



This option edits a file type (extension) in the filter list.



This option removes the selected file type (extension) from the filter list.



Type the folder name to add to the filter list.



Browse the computer to find a folder to add to the filter list.



Type the file extension to add to the filter list.



File List

This is a list of all the previous versions of files that GoBack can recover.

Old file versions that cannot be recovered are not listed.



Recover To…

This option recovers the selected file to a specified location.



Rescue Files

This option recovers all of the checked files to their original locations.



Open

This option opens (views or runs) the selected file.



GoBack Menu

This button will display the GoBack Main Menu.



Locate Files Matching

You can enter a portion of a file you are looking for in this box.



Locate Now

This option limits the file list to those files which contain the text in the "Locate Files Matching" box.



Locate All

This option resets the file list to show all files, regardless of the text in the "Locate Files Matching" box.



Drive List

This is a list of the hard disks that can be reverted. One or more can be selected and reverted at the 
same time.



Inactivity List

This is a list of times that the system was inactive for a period of time. The selected hard disks can be 
reverted to any of these times.



Inactivity Filter

This can be used to reduce the number of entries in the inactivity list to periods at least as long as the 
slider value.



Usage Graph

This graph shows the amount of hard disk use over time.



Detailed View

This option switches the usage graph between long-term and short-term views of hard disk use.



Show Usage

This option switches the usage graph between "activity/inactivity" and "amount of use" modes.



Selecting this option will cause the disk reversion to be in effect only for the next boot.



Revert

Selecting this will revert all of the selected disks to the selected time.



GoBack Menu

This button will display the GoBack Main Menu.



Applies and saves any changes you have made and then closes this dialog box.



Closes this dialog box without saving any changes you have made.



Help

Opens GoBack Help.



GoBack Drive Window Assistance
This help window will guide you through the most common operations of the GoBack Drive Window.
What are you trying to do?
{button ,JI(`',`HID_GBDRIVE_HOWTO_RETRIEVEFILES')} Retrieve files from the past.
{button ,JI(`',`HID_GBDRIVE_HOWTO_REVERTDISK')} Revert a hard disk to the way it was in the past.



Retrieving Files from the Past
1 On the Calendar, click on the date from which to retrieve the files. You can click on the arrows to change which month is 

displayed.
If the date you wish to select is gray, then GoBack does not have any information for that date and is unable to retrieve files 
from that date.

2 Select the time from which to retrieve the files:
If you know what time to retrieve the files from, click on the box below the clock, type in the time, and press Enter.
If you aren’t sure what time to retrieve the files from, you can use the event log to help you determine what you were doing at 
the time. Once you find the appropriate time, click on the System Safe Point nearest to that time.

3 Click the Create GoBack Drive button. A new drive will appear in Windows Explorer.
4 Use Windows Explorer to locate the files you wish to retrieve on the GoBack drive and copy them to your normal drive.
Tips
· You can double-click on an event in the event log to create a GoBack drive without having to click the Create GoBack Drive 

button.
· To reduce the number of entries in the file list, use the filtering option (in the View menu).
· If you only need to retrieve one or two files, you might want to use the GoBack File Recovery Window.
Note
· If you create a GoBack drive near the beginning of the GoBack log, you will see a warning dialog telling you this. If this 

happens, you should try to copy any files you need from the GoBack drive to a different physical drive (e.g., a floppy disk) to 
ensure that the file doesn’t get lost before you get it.



Revert a Hard Disk to the Way it was in the Past
1 On the Calendar, click on the date to revert the disk to. You can click on the arrows to change which month is displayed.

If the date you wish to select is gray, then GoBack does not have any information for that date and is unable to revert to that 
date.

2 Select the time from which to revert the disk to:
If you know what time to retrieve the files from, click on the box below the clock, type in the time, and press Enter.
If you aren’t sure what time to revert to, you can use the event log to help you determine what you were doing at the time. 
Once you find the appropriate time, click on the System Safe Point nearest to that time.

3 Click the Revert Drive button. GoBack will need to restart your computer to complete the process.
Tip
· If you know what time you want to revert your hard disk to, you might want to use the GoBack Disk Revert Window.



GoBack File Recovery Window Assistance
This help window will guide you through the most common operations of the GoBack File Recovery Window.
What are you trying to do?
{button ,JI(`',`HID_GBFILE_HOWTO_RECOVERFILE')} Recover an old version of a file.
{button ,JI(`',`HID_GBFILE_HOWTO_OPENFILE')} View an old version of a file.



Recovering an old Version of a File
1 Click to select the file you wish to retrieve from the file list.
2 Click the Recover To button.
3 In the Recover To dialog, specify where to save the recovered file and what the file should be called. By default, the file will be 

recovered to the location where it originally existed, with its original name.
Tip
· If you wish to recover more than one file from the same time in the past, creating a GoBack Drive from the GoBack Drive 

Window will allow you to recover many files at once.



Viewing an old Version of a File
1 Click to select the file you wish to retrieve from the file list.
2 Click the Open button. If the selected file is a document, it will be opened by the application that is associated with the file’s 

type. If the selected file is a program, it will be run.
Tip
· If you wish to recover more than one file from the same time, creating a GoBack Drive from the GoBack Drive Window will 

allow you to recover many files at once.




